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Complete Train Control 
Run Your Trains, Not Your Track!

Features:
 ▪ Digitrax SoundFX®v3 Sound System 

Your locomotives will sound “in scale” like the real thing with SoundFX v3 
Customizable with 16, 12 or 8 bit .wav file sounds 
Works with all SoundFX 8 and 16 bit sound projects 
Up to 6 simultaneous voices 
Download sounds with a Digitrax Sound Programmer and SoundLoader II 
16 megabit On Board Sound Memory 
Cam input-synchronized steam-chuff option for steam locos 
Scalable Speed Stabilization configured for sound operation 

 ▪ SoundFX v3  does not require an external rate sensor to vary workload.

 ▪ Factory 8 Ohm 13 mm round speaker .

 ▪ Smart Power Management- no more booster or programmer shutdowns! 

 ▪ Program CVs using any Digitrax Compatible Control system without having 
to buy any extra equipment.

 ▪ EZ Drop-in connections for Track, Motor and Function Control

 ▪ Series 7 Enhanced Decoder Features.

 ▪ Digitrax FX3 Functions-Control lights and functions for prototypical lighting 
effects and on/off control.

 ▪ Configurable FX3 Pulse Function available on all function outputs.

 ▪ Digitrax LocoMotion® System – Lets your trains run like the real thing!

 ▪ 2 Digit and 4 Digit Addressing.

 ▪ Basic, Advanced & UniVersal Consisting.

 ▪ SuperSonic motor drive for silent operation.

 ▪ Direct and Operations Mode programming.

 ▪ Decoder Reset by CV8, with or without speed table reset.

 ▪ Transponder Equipped ready for transponding ID on your layout.

 ▪ Power-on Motor Isolation Protection, helps prevent damage to your decoder.

 ▪ DCC Compatible.

 ▪ FCC Part 15, Class B RFI compliant.

 ▪ Operates on DCC track voltage 9V minimum. to 18V maximum.

SDXN167K0A SoundFX®v3
Fits many Kato N locomotives
8 CV Selectable Steam & Diesel Sound  
Schemes Included

N Scale
Mobile Decoder with SoundFX v3
1.0 Amp/2 Amps Peak
6 FX3 Functions, 200ma Output
8 Ohm 13mm round Speaker  
100uF Capacitor
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Parts List:
1 SDXN167K0A Sound Decoder with SoundFX® v3, with 8 Ω 13 mm 
round speaker and 100uF cap
1 Instruction Sheet

Visit www.digitrax.com for the latest information, technical updates and 
additional locomotive-specific installation instructions. CAUTION: 
Programming or layout track voltages should not exceed 18V 
when using this decoder, or non-warranty damage may occur. 

Installation Instructions

1. Carefully disassemble the Locomotive.  Remove the Factory Light board by 
carefully prying up board retainer and moving board slightly forward.  

2. To make a 13mm speaker mounting cavity in the E8 body:  Detach the track 
springs, motor, flywheels, towers and gear parts as shown in figure 1.Drill or 
Dremel out a cavity in the rear of the frame casting to fit the 13mm speaker 
body, and the capacitor below this in hole through to the bottom.

3. Reassemble the  trucks, drive train towers and motor and mount, and set the 
motor brush tabs upright to allow the decoder to be installed.  

SDXN167K0A decoder

Figure 1: SDXN167K0A: Disassembled E8 example Locomotive
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4. Add a small amount of kapton tape around the track springs at the motor 
tab location to insulate at the point the motor tabs cross them.  The Motor 
tabs must not touch the track springs electrically.  Align and place the track 
springs back in position on the motor mount guide pins, with ends pointing 
downwards.

5. Install the SDXN167K0A by placing it over the track springs on the plastic 
motor mount and sliding back slightly.  

6. Bend over the motor tabs onto the PCB top and hold these by pressing down 
the board retainer,  as shown in figure 2. 

7. The capacitor  can be placed in the speaker hole and held with a piece of 
double sided tape so its case and wires do not short to frame metal.  

8. Place the speaker on the top of the speaker hole as shown. The speaker and 
capacitor wires should be undamaged and fit above the decoder. 

9. Replace the locomotive shell.
10. Place the loco on an active DCC track powered by a compatible DCC system 

and select the factory default address 03 to enable sounds for testing.
11. Be sure F8 (mute) is OFF to allow sound output, and then press  

F1 (bell) or F2 (whistle/horn) ON to hear the associated sounds. 

Note: This is an example installation for this Kato E8 locomotive.  Other installs 
may require similar modification of the locomotive to make space for the speaker 
and capacitor.  For some installs you will need to modify the length of the front 
and rear headlight white LEDs.  It is recommended that you modify the led leads, 
and use a temperature controlled soldering iron to solder onto them, to avoid 
damaging the PCB pads.  Take care not to overheat or pull off pads which will 
cause non-warranty damage. Only solder to pads shown on Fig 3 page11.

Figure 2: SDXN167K0A: Completed installation without locomotive shell

100uF capacitor,  under speaker

8 Ohm 13mm round Speaker mounted on 
user formed  13mm cavity

plastic motor mount

Option: remove rear led by clipping leads close to decoder

motor mount guide pin
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Speaker Mounting and Baffle or Enclosures:
The sound performance, volume and efficiency of any attached speaker(s) 
is greatly affected by the mounting system and required baffle or enclo-
sure. The included 8 ohm box speaker is pre-mounted in a baffle for your 
convenience. Additional baffles or other mounting systems may need to 
be taken into consideration when installing. Baffles are used to isolate the 
speaker diaphragm front sound waves from the “out of phase” rear sound 
waves to minimize sound cancellation, particularly at lower frequencies.  
For the most efficient sound generation, the cubic volume of the baffle 
should be as large as practically possible, and the baffle walls should be 
acoustically rigid so not to allow acoustic interference.

Digitrax SoundFX®v3 System:
For a more prototypical railroading experience, your decoder can be  
customized for your specific locomotive by programming some of the 
Configuration Variables, or CVs, available. 
Digitrax SoundFX v3 lets you make your locos sound “in scale” like the 
real thing! The SoundFX v3 sound CVs used in the range of CV140 to 
CV240 let you customize your decoder without having to reload a new 
sound project. Digitrax sound decoder CVs can be programmed using 
either a programming track or with the operations mode using the main 
line. See the Digitrax web site for more information on programming 
CVs.

Customizing Your Decoder:
This decoder  will initially operate and generate sound using address 03. 
On your Digitrax system, simply select the decoder’s address and the 
sounds will start. [On some DCC systems, it is necessary to select the 
decoder address AND send a command to start the sounds]. 

The factory supplied sound project loaded into the SDXN167K0 sets 
CV60 to 00 for a E8 diesel locomotive scheme. The other 7 preloaded 
schemes are selectable with the value 1 to 7 in CV60. If the locomotive 
you’re installing in is not one of the preloaded schemes you can download   
the appropriate project from the Digitrax website.

Sound Control Functions: 
The following table shows how each decoder function controls sounds for 
the factory sound project.
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Sound Control Functions: 
The following table shows how each decoder function controls sounds for 
the factory sound project.
Function# Function Controls Notes

F0 Lights F0 controls directional white/yellow wires

F1 Bell CV146 controls rate, CV157 selects bell type
F2 Horn/Whistle CV150 selects horn choices
F3 Coupler crash Auto coupler/brake set by CV151 max speed

F4 Air feature disable F4 OFF enables pop-off,
drier and starts compressor/air pump

F5
Diesel = Dynamic brake
Fans Steam = Water
Pump turbine

F6 Diesel = Notch Up
Steam = Blow-down

Notch UP if CV155=01 or
02

F7
Crossing Gate Air horn or;
Diesel = Notch DOWN
Steam = Wheel slip

Notch DOWN, if CV155 = 01 or 02
(Crossing Gate active if in Diesel mode and 
CV155=0)

F8 Mute Control F8 ON is mute

F9 Brake squeal

F10 Crossing Gate
Air horn Sequence

F11 Steam = Greaser
F12 Steam = Safety Blow-off

Configuration CV setup:
The following tables show the CVs used in this decoder sound project and
how it is set up at the factory to operate various sounds with a throttle.  
SFXv3 CV assignments are generally consistent with earlier Digitrax 
decoders.  

Motor Drive Frequency: CV9
CV9 value sets motor frequency in KHz, range 4 to 50KHz for CV values 
01-50.  00 sets a supersonic 16KHz default.

Motor Back EMF (BEMF) Trim: CV10
Value 64 and up to 127 slows down step1 BEMF motor speed. 00 default 
also sets this to 64.  

Motor Control: CV55/CV56/CV57
CV55 sets BEMF static gain, CV56 controls dynamic gain, CV57 sets 
BEMF Intensity.  This is same as prior Digitrax decoders.  

Master Volume: CV58
The value in CV58 sets the master sound volume. CV140 to CV145 trim 
volumes for specific sound types.  When downloading a new .wav sound 
file for any of the sounds in a scheme, be careful to set a volume level that 
does not overdrive the speakers, which may cause distortion or damage.  
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CV# Sound Control Usage Range Default 

Value

01 2 Digit Address 1-127 03

11
Sound Time Out, 06 = Sound ends when loco address is 

unselected, 00=Sound stays on after loco is unselected
06

29

Configuration Register - Speed steps, 2 /4 digit address-

ing, Analog Mode, Normal direction of travel, speed 

tables

06

49 FX effect: Forward Light (FOF) - Headlight 00

50 FX effect: Reverse Light (FOR) - Reverse Light 00

51 FX effect: Function 1 lead 00

52 FX effect: Function 2 lead 00

58 Master Volume (F8 used for Mute) 1=min 00=max 00-15 09

60 Sound Scheme Select 00-07 00

132 Notch Rate 00-255 127

133
Steam CAM config, 128=>EXT cam, 1-127=>DRIVER 

dia”
01-128 63

134 Steam Gear Ratio Trim, 32 = 100% Ratio 00-255 32

135 Mute Volume 00-64 00

140 Prime Mover / Chuff Volume 00-64 60

141 Bell Volume 00-64 25

142 Horn/Whistle Volume 00-64 60

143 Time-Scattered Air Effects Volume 00-64 30

145 Miscellaneous Volumes 00-64 40

146 Bell Ring Rate (1= 24 milliseconds delay) 01-100 07

147 Air Drier Rate (1= about 2 seconds delay) 01-64 02

148 Compressor Run Rate (seconds delay) 00-255 30

149 Air Compressor On Time 00-255 20

150
Horn/Whistle Setup (Default=0, Playable Horn=1, Alter-

nate Horn=2 +128 for playable volume.)

00-07 or 

128-135
00

151

Auto Coupler Sequence Threshold Value-Peak speed for  

coupler/brake when direction change occurs and F3 is 

ON

00-64 48

152 Project Author ID, Digitrax=221 221

153 Project ID 16

154 Steam Blow down / Safety Volume 0-64 60

155 Notching/Slip Mode: 00=Automatic, 00

157 Bell Selector 00-03 00
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Selecting the Sound Scheme on Your SDXN167K0:  CV60   
The SDXN167K0 comes preloaded with 8 different sound schemes, 7 die-
sel and 1 Steam.  The active scheme is selected by the value in CV60, as 
shown in following table. Scheme 6 is spare to load other prime movers.
 

CV60 
value

Factory Sound scheme

0 E8 diesel
1 PA-1 diesel
2 F7 diesel
3 F40-PH diesel
4 P42 diesel

5 F3 diesel
6 E5 diesel
7 4-8-4 Steam

Selecting Horns/Whistles/Bells: CV150, CV157 
Each Diesel Scheme can be configured with one of 8 different horns using 
CV150, and one of 4 different bells using CV157.  

Each Steam Scheme can be configured with one of 3 whistles using 
CV150 and one of 4 bells using CV157.  To enable playable volume for 
your selected horn or whistle add 128 to the selected value (ex. Playable 
volume on horn 2 is enabled with a value of 130, 02+128=130)

Diesel Notching: CV132 and 155
Sound CV155 is provided to select Diesel engine “notching” modes. The 
default of CV155= 00 provides “automatic notching” that changes the 
diesel RPM settings at 8 distinct throttle speeds that are configured by 
Sound CV132 and follow speed directly. 

Sound CV155=01 selects “semi-automatic notching” mode that allows F6 
ON to increase the notch up from the current throttle setting and F7 ON 
to decrease back down towards the lowest current throttle notch setting. 
Sound CV155=02 selects “manual notching” mode that allows F6 ON to 
increase the notch setting and F7 ON to decrease the notch sound setting, 
irrespective of the throttle speed, which then controls just the motor 
speed. 



© 2023 Digitrax, Inc. www.digitrax.com— 8 —

Steam Exhaust Chuff / Cam Configuration and Gear Ratio 
Trim: CV133 and 134
CV133 controls the Steam Chuff / Cam configuration in the decoder. It 
allows you to set the value of the CV equal to the diameter of the driver in 
inches from 1-127.  Set CV133 to 128 to enable the external cam lead con-
trolling steam exhaust chuffs.  CV134 controls the gear ratio trim, where 
a value of 32 equals a 100% ratio.

Bell and Air Effect Rates: CV146-149
CV146 controls the bell rate or time between rings of the bell, it has a 
range from 1-100 with each increment adding 24ms of delay.  CV147 con-
trols the drier rate, it has a rage from 1-64 with each increment adding 
about 2 seconds.  CV148 controls the Compressor/ Air pump start rate 
and CV149 controls how long the Compressor/ Air Pump runs.

Auto Coupler Sequence Threshold Value: CV151
CV151 controls the threshold at which coupler and brake sounds are
automatically played when the locomotive direction changes and func-
tion 3 is enabled. CV151 has a range of 0-60.

Loading Other Sound Projects in your SDXN167K0A:
Decoder sounds can be re-loaded or customized using a Digitrax SFX 
programmer and your computer with the SoundLoader II software.  Both 
the software and many alternate Sound Project files(SPJ) are available 
from the Digitrax Sound Depot web site. It takes only a few minutes to 
download the new sounds to your decoder. 

There are other sources for SPJ’s, The free group, https://groups.io/g/
AnPRR, has over 300 SPJ’s  that are detailed for single locomotive 
sounds, versus the factory SPJ that has multiple loco samples loaded for 
customer convenience.

Prior SFXv1/v2 SPJ’s can be loaded into SFXv3 decoders if properly 
sized. SFXv3 SPJ’s may run on older SFXv1/v2  decoders with decreased 
functionality.  For example, earlier v1/2 decoders may be limited to 3 or 
4 sound channels, whereas SDXN167K0A decoders can run new SFXv3 
sound projects with up to 6 simultaneous channels in the scheme.  

SoundFXv3 DC Operation Mode:
1. Digitrax SoundFX v3 decoders will operate on smooth DC power if 

CV29 is default value 06, allowing Analog Mode conversion.
2. Sound/motor will not start until about 6VDC on the track.
3. It is not practical to Consist/MU decoder equipped locomotives with 

non-decoder equipped locomotives, since they will not operate at 
same speed on shared track DC power.



© 2023 Digitrax, Inc. www.digitrax.com— 9 —

SDXN167K0A Troubleshooting:

If sound does not start in the decoder when on powered track:
1. Make sure you have selected the locomotive address on a throttle. 

The sound will not startup and run unless the locomotive is ad-
dressed by the system.

2. Check your installation to make sure the decoder is installed  
properly.

If the sound output seems distorted:
1. Check the speaker cone for magnetic debris that may have collected 

there. Debris on the speaker must be removed and this, or damage 
will cause a loss of sound quality.

2. Be sure that the CV58 volume is not set at a level that sets sound 
power too high for the track power and speaker being used. 

If motor does not run:
1. Check the motor is properly connected.
2. Make sure locomotive address is correct and selected. Activate F0/

lights to see if decoder is powered and addressed properly.
3. If Front and Rear lights come uncontrollably solid ON and wink off 

once every 4 secs, the motor is not properly isolated from stray volt-
ages.  Check wiring. 

If the sound in your decoder shuts down after you stop it and 
you are not using a Digitrax system for control:   
On some DCC systems decoders are not addressed by DCC packets after 
the locomotive is set to 0 speed. 

In this case after the CV11 timeout elapses (6 second default), sound will 
“shutdown.”. To defeat this feature, set CV11=00 to remove the timeout 
and shutdown. To make sounds, the decoder must have a command 
addressed to it at least once.

If you have trouble reading back CVs on the programming 
track: 
This may be due to insufficient current draw for program acknowledg-
ment.  You can always just re-program or write the CV value into a CV to 
get the desired results, even if reading CVs does not work. 

OPS/Mainline mode is recommended for writing to (programming) all 
CVs except CV01, CV17 & CV18 (2 digit and 4 digit addresses). 
If a second DCC decoder is present that is not SoundFX compatible then 
correct read back of CV data is not possible, since CV read back was not 
originally designed for multiple decoder read back.
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I want to load new .wav files with 12 bit resolution instead of 8 
bit, but do not have enough room in the sound flash.  
Save your project (.spj ) to a new named project: “ File> Save Sound 
Project File As” saves the project file with a new name. Next, right click 
on any .wav file you do not need or use, and select “Remove Associa-
tion”.  This will skip this .wav when pressing the green download “ALL”, 
or  “Program Wavs” button, and the SFX decoder will not output this, 
or ignore/ skip this sound as silence.  This frees up memory for you to 
download 12 or 16 bit .wav files that you wish to use, and be within the 
memory size available.

You can skip all .wav files that are not needed for the scheme you want to 
run, and/or can substitute any .wav versions you may prefer.  Remember 
to save any modified project version with “File> Save Sound Project File”. 

If you have free memory, you can download any replacement single .wav 
of your choice e.g. new; horn fragments/bells/prime movers by right 
clicking on the .wav entry line and selecting “Download this Sound”.

The SDXN167K0 plays a Steam scheme, but I want the default 
Diesel scheme:   
If the factory sound project with the 8 schemes has not been changed, 
program CV60 back to a value of 00 to reselect the default E8 diesel 
scheme. The SDXN167K0 sound project is on the web site so you can 
reload this if you get lost.  Program CV8 to 8 to restore factory settings.

I have loaded a new sound project but, the CVs and Function 
controls are not what I expected:   
In SoundLoader II, open the sound project .spj file you programmed with 
“File>Open Sound Project File”.  Now select “View>View Project De-
scription”, the Project description should define how the project operates 
and how CVs and functions are configured for sound generation.

I have loaded new .wav files for a bell in 16 bit resolution vs the 
12 bit, but don’t hear much difference. Why?  
With most small speaker systems it is tough to hear difference between a 
12 and 16 bit download, or even an 8 and 16 bit download.  This is partic-
ularly true if the is any noise in the layout room.  In most cases the extra 
cost for “CD quality sound” is not justified.  With a number of sound loco-
motives running at same time it gets quite  noisy, and so many operators 
simply turn down the decoder volumes anyway.
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I want to load new .wav files with 12 bit resolution instead of 8 
bit, but do not have enough room in the sound flash.  
Save your project (.spj ) to a new named project: “ File> Save Sound Proj-
ect File As” saves the project file with a new name. Next, right click on 
any .wav file you do not need or use, and select “Remove Association”. 

This will skip this .wav when pressing the green download “ALL”, or  
“Program Wavs” button, and the SFX decoder will not output this, or ig-
nore/ skip this sound as silence.  This frees up memory for you to down-
load 12 or 16 bit .wav files that you wish to use, and be within the memory 
size available.

You can skip all .wav files that are not needed for the scheme you want to 
run, and/or can substitute any .wav versions you may prefer.  Remember 
to save any modified project version with “File> Save Sound Project File”.

Figure 3: SDXN167K0A: connection diagram
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Note:  The CV60 scheme4 P42’s 7FDL16 prime mover is a 4-stroke 
diesel, so has a lot of sound energy at a slower crankshaft rate from about 
60-100Hz.  A fraction of an inch speaker size has difficulty efficient-
ly coupling to a adequate sound pressure level these lower frequency  
prime-mover sounds.  By contrast 2-stroke diesels like EMD567 etc., 
have higher prime mover frequencies at about 150-300Hz that couple as 
“louder” prime mover sounds.  

The decoder low frequency response can drive high power at 50Hz and 
lower, but unfortunately a small speaker and baffle cannot make high 
volume without damage due to overdriving the diaphragm limits.  This is 
a physics limitation of small transducers that can fit in smaller locomo-
tives.

Warranty & Repair
Digitrax gives a one year Warranty against manufacturing defects for 
this product.

Visit www.digitrax.com for instructions for tech support and returning 
items for repair.  

Please return warranty items directly to Digitrax - DO NOT re-
turn items to place of purchase.
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